2 Eclipse — en handledning

Inledning

Har beskrivs Eclipse, den programutvecklingsmiljo som utnyttjas i programmeringskurserna.
Mera information finns pa:

http://www.eclipse.org Eclipse hemsida. Enorma méngder information.

http://help.eclipse.org Hjalpsidor for Eclipse, senaste versionen. Dessa
hjdlpsidor finns ocksa lokalt i Eclipse-systemet,
under Help Contents i Help-menyn.

http://www.eclipse.org/downloads/, Nedladdning av Eclipse for olika datorer. Valj
"Eclipse IDE for Java Developers”.

Det finns ocksa ménga handledningar som &r betydligt utforligare dn denna, till exempel pa
www.vogella.com/articles/Eclipse/article.html.

Att utveckla Javaprogram

Ett Javaprogram bestar av en eller flera klasser som lagras i filer med tilldgget .java. Dessa filer
innehaller “vanlig text” (bokstdver, siffror och andra tecken). Innan man kan exekvera (kora)
programmet maste filerna kompileras (6verséttas) till ett annat format (bytekod) som datorn
“forstar”. Bytekoden lagras i filer med tilligget .class. Oversittningen gors av en kompilator
som heter javac, och programmet kors av en Javatolk som heter java.

Allt detta kan man hantera manuellt. Da editerar man .java-filerna med Emacs eller en annan
texteditor, kompilerar dem med javac och kor programmet med java. Det kan se ut s& hér:

% emacs HelloWorld.java & Starta en editor, skriv foljande programtext:
public class HelloWorld {
public static void main(String[] args) {
System.out.println("Hello, world!");

}

}
% javac HelloWorld.java Kompilera programmet
% 1ls Lista innehallet i katalogen
HelloWorld.class HelloWorld.java Tv4 filer: kompilerad kod och killkod
% java HelloWorld Kor programmet
Hello, world!
£

Det dr inget fel med att utveckla program pa detta sétt, men det har en del nackdelar: stora
program bestar av manga klasser och det kan vara svart att halla reda pa dem, man maste
komma ihdg att kompilera varje fil som man dndrar, ndr kompilatorn hittar fel i ett program
madste man i editorn hitta motsvarande rad i filen for att kunna rétta till felet, om man vill folja
exekveringen av ett program maste man ha en separat “debugger” (felsokningsprogram).

Ett alternativt satt att arbeta dr att anvanda en integrerad utvecklingsmilj6 (Integrated Deve-
lopment Environment, IDE). Det &r ett program med ett grafiskt anvandargranssnitt dir editor,
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kompilator och debugger &r integrerade. Man startar IDE-programmet och hanterar sedan alla
moment i programutvecklingen inifrdn denna miljo.

Programutvecklingen bestér fortfarande av editering, kompilering och programkorning, men
det blir enklare att utféra dessa moment — de utfors av IDE-programmet genom att man klickar
pé knappar eller viljer ur menyer.

Det finns ménga olika IDE-program, mer eller mindre avancerade (Eclipse, IDEA, JBuilder,
Netbeans, JCreator, ... ). I programmeringskurserna utnyttjas Eclipse.

Eclipse
Oversikt

Eclipse dr ett avancerat IDE-program som erbjuder all funktionalitet som behdvs for utveckling
av Javaprogram. Det finns ocksd ett stort antal “plugins” som utokar Eclipse med nya mojligheter
(utveckling av webbprogram, databasprogram, diagramritning, andra programsprdk &n Java,
osv). Programmet dr gratis.

Eftersom Eclipse har sd minga mojligheter dr det inte helt enkelt att ldra sig att anvinda
fullt ut. Man maste satta sig in i en hel del terminologi och ldra sig hitta bland alla menyer och
kommandon. Men grunderna &r inte alltfor komplicerade, och de beskrivs har.

Naégra termer maste man kénna till:

Projekt (project) Ett antal .java- och .class-filer som hor ihop, till exempel alla
filer som behovs for en laboration eller en inldmningsupgift. Motsva-
ras av en katalog i filsystemet.

Arbetsomrade (workspace) Det omrade ddr man sparar de projekt som man skapar.
Motsvaras av en katalog i filsystemet (projekten ar underkataloger till
denna katalog).

Perspektiv (perspective) Utseendet hos Eclipsefonstret. Ett perspektiv har ett an-
tal fonster och knappar for kommandon.

Det finns massor av mojligheter att stélla in Eclipse sa att det fungerar pé olika sétt (Preferences
i Window-menyn). Varje instédllningssida har en knapp Restore Defaults som stéller tillbaka alla
instillningar till de ursprungliga.

Anvandning av Eclipse

Vi forutsétter i detta avsnitt att Eclipse har installerats (hur man gor skiljer sig ndgot mellan olika
datorer; se separata anvisningar). Vi forutsatter ocksa att vi har skapat ett arbetsomrade med ett
projekt test0 som innehdller en fil HelloWorld.java och en kompilerad fil HelloWorld.class. Hur
man skapar projekt och filer visar vi i nédsta avsnitt. Nar man startar Eclipse far man ett fonster
som visas i figur 1| (under Linux, det kan se nagot annorlunda ut pd andra datorer):

Om det inte stdr Java i fonstrets titelrad sa ar fel perspektiv aktiverat. Byt da perspektiv med
Open Perspective i Window-menyn. I projektvyn (langst till vanster under Package Explorer)
ser man de projekt man har skapat. Nar man klickar pa pilen vid ett projekt sa 6ppnas projektet
sd att man ser innehallet. .java-filerna finns i katalogen src under (default package), .class-filerna
finns i en katalog bin som inte visas i projektvyn.

Omradet i mitten &r en texteditor. Nar man dubbelklickar pa en fil i ett projekt sa laddas filen
in i editorn. Man kan editera flera filer samtidigt i olika flikar.

I editorn arbetar man som i alla editorer: man skriver och tar bort text som vanligt, markerar
text genom att dra med musen, klipper ut och klistrar in med CONTROL-X och CONTROL-V, och
sd vidare. Eclipse-editorn kédnner till hur Javaprogram ska formateras, sa den gor automatiskt
indragningar dar de ska vara, stoppar in en hdgerparentes av ratt slag niar man skriver en
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Figur 1: Eclipse-fonster, Java

véansterparentes, och sa vidare. Man kan till och med formatera om en hel fil s& att programmet
foljer kodkonventionerna; det géor man med kommandot Format i Source-menyn.

Eclipse-editorn kontrollerar ocksd programmet och kompilerar det under tiden man skriver.
Om man skriver ndgot som bryter mot Javas regler s markeras rader som innehaller fel med
kryss till vanster om raden. Man far en forklaring av felet genom att hdlla musmarkoéren over
krysset.

Omrédet under texteditorn har flera flikar. I Console visas utskrifter frdn program som kérs,
och dar skriver man ocksa indata till programmet. I Problems visas felmeddelanden som finns i
filer som man sparat.

Man kor ett program genom att hogerklicka pa filen som innehéller main-metoden i projekt-
vyn och vélja Run As > Java Application. (Eller genom att vilja Run As > Java Application i
Run-menyn eller genom att klicka p4 Run-ikonen @ i verktygsraden.)

Om man rakat stinga till exempel editorfonstret utan att vilja det eller stallt till nagot an-
nat med Javaperspektivet, sd kan man aterstilla perspektivet till utgdngslaget med kommandot
Reset Perspective i Window-menyn.

Skapa projekt och klass

Nu visar vi steg for steg hur man skapar ett nytt projekt med en klass och hur man kor pro-
grammet. Projektet ska heta test1 och innehalla en klass Calculator med foljande utseende:

/** Calculator ber&dknar summan av tva tal */
public class Calculator {
public static void main(String[] args) {
double nbrl = 5.5;
double nbr2 = 11.3;
double sum = nbrl + nbr2;
System.out.println("Summan av talen &r " + sum);

Detta &r inte ett vettigt program, eftersom det bara kan berdkna summan av talen 5.5 och 11.3.
Om man vill berdkna summan av tva andra tal mdste man dndra i programmet och kompilera
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om det. Nagot mera anvandbart skulle programmet bli om det lédste in talen fran tangentbordet,
men vi gor det sd enkelt som méjligt nu.
Gor foljande:

1. Skapa projektet testl. Vilj File > New > Java Project, skriv namnet pé projektet, klicka pa
Finish.

2. Skapa en fil Calculator.java. Markera projektet test1 i projektvyn, klicka pa New Java Class-
ikonen @ i verktygsraden, skriv namnet pé klassen (Calculator), klicka pd Finish.

3. Oppna projektet, src-katalogen och (default package) genom att klicka pa pilarna. Dubbel-
klicka pa Calculatorjava for att ladda in filen i editorn. Som du ser sd har Eclipse redan
fyllt i klassnamnet och de parenteser som alltid ska finnas. Komplettera klassen med main-
metoden som visas ovan.

4. Spara filen.

5. Kor programmet genom att hogerklicka pa filen och vélja Run As > Java Application.
Utskriften som gors med System. out . println hamnar i konsolfonstret (om utskriften inte
blir Summan av talen &r 16.8 sa har du skrivit fel i programmet).

En del program behover utnyttja klasser som inte finns i det aktuella projektet. (Egentligen gor
alla program det, de anvinder Javas standardklasser, men dessa ar alltid tillgdngliga och man
behover inte gora ndgot for att programmen ska komma &t dem.) Man maste for projektet ange
var dessa klasser finns. Det gér man genom att hogerklicka pa projektet och vélja Build Path >
Configure Build Path.

Sedan finns det tva fall:

e Klasserna som ska utnyttjas finns i ett annat projekt i samma arbetsomrade. Klicka pa
Projects > Add. .. och markera projektet som innehaller klasserna.

o Klasserna som ska utnyttjas finns i en biblioteksfil (.jar-fil, Java Archive) i ett annat projekt.
Klicka pé Libraries > Add JARs... och vidlj rétt .jar-fil. Om .jar-filen finns utanfor arbets-
omradet klickar man i stillet pd Add External JARs... och letar upp filen.

Hitta fel i program

Fel i program &r av tva slag: dels "sprdkfel” som kompilatorn hittar (man glommer ett semi-
kolon, glommer att deklarera en variabel, stavar fel till ett ord och liknande fel), dels “logiska
fel” som medfor att ett program ger felaktigt resultat nar det exekveras.

Som exempel tar vi programmet som berdknar summan av tva tal frdn féregdende avsnitt.
Satsen som berdknar summan och sparar den i variabeln sum ser ut s har:

double sum = nbrl + nbr2;

Om vi i stdllet hade skrivit dubbel sum = nbrl + nummer2; hade vi gjort tvd sprikfel: typen

for reella tal heter double, inte dubbel, och variabeln dar virdet av det andra talet finns heter

nbr2, inte nummer2. Kompilatorn markerar alla fel av denna typ, och de &r for det mesta enkla att

korrigera (det kan vara svart att tolka felmeddelandena i borjan, men det lar man sig efterhand).
Logiska fel dr svérare att hitta. Antag att vi hade skrivit satsen pa foljande satt:

double sum = nbrl - nbr2;
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Detta dr en helt korrekt sats och programmet kan kompileras och koras utan problem, men
resultatet blir inte korrekt (man far utskriften Summan av talen &r -5.8).

Det hédr programmet dr sé litet och felet dr s& uppenbart att man kan hitta felet genom att
bara titta pa programmet. Men i allménhet dr det inte sa enkelt: “riktiga” program dr mycket
storre och felet kan vara mycket mera komplicerat.

For att hitta logiska fel behdver man skaffa sig information om vad som hander under exekve-
ringen av programmet. Ett sétt att gora det ar att lagga in utskrifter av viktiga variabelvirden pa
lampliga stéllen i programmet (det &r ju egentligen det vi gjort i ovanstdende program, dar vi
omedelbart efter summeringen skriver ut summavardet). Detta sitt dr dock svarhanterligt och
tidsodande.

Battre ar att utnyttja en debugger (“avlusare”). Da far man mojlighet att sjdlv kontrollera
exekveringen av programmet: man kan koéra programmet rad for rad och man kan under tiden
titta pa hur variabelvdrdena dndras. Man kan ocksd sdtta brytpunkter i programmet. Nar man
sedan startar programmet sa stoppas exekveringen nédr den nér en brytpunkt.

Man sétter en brytpunkt pa en rad genom att dubbelklicka till vinster om raden, och man
tar bort en brytpunkt pa samma sétt. Nar man har satt en brytpunkt kan man starta debuggern.
Det gor man genom att hogerklicka pa filen och vilja Debug As > Java Application. Eclipse byter
till debug-perspektivet. Fonstrets nya utseende visas i figur 2}

I mitten finns editorfonstret. Den rad som stér i tur att exekveras d&r markerad med en pil.
Ovanfor editorfonstret finns en vy med information om det kérande programmet. I verktygsra-
den finns ikoner fér kommandon. De viktigaste &r:

Resume — fortsitt exekveringen till ndsta brytpunkt eller till programmets slut.

Terminate — avsluta exekveringen av programmet.

Yl ¥

Step over — exekvera en rad i programmet.

Step into — exekvera till nédsta rad, gé in i metoder som anropas.
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Figur 2: Eclipse-fonster, debug
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Importera och exportera filer

Nér man arbetar med Eclipse har man normalt alla sina filer i projekt i arbetsomradet. Om man
har filer ndgon annanstans kan man importera dem till ett existerande projekt. Det gor man
genom att hogerklicka pé projektet, vélja Import... > General > File System och leta upp filerna.
Genom att i stéllet vélja Export kan man exportera filer.

Man kan ocksa importera och exportera hela projekt. Det gor man genom att hogerklicka i
projektvyn och vélja Import > General > Archive File respektive genom att hogerklicka pa ett
projekt och vélja Export > General > Archive File. Ett arkiverat projekt sparas som en kompri-
merad .zip-fil.

Att skapa nya projekt (for egna dvningar)

Du kan skapa egna projekt i Eclipse, ddr du kan 6va pa att skriva egna program. Om du lagger
dina program i egna projekt hamnar de i en egen katalog i Eclipse, precis som laborationerna.

Hur du skapar ett nytt projekt ser du i avsnittet “"Skapa projekt och klass” (som borjar pa
s. BI). Hér beskrivs hur du gor kursens klasser (SimpleWindow, Square, m. fl.) tillgingliga for
ditt nya projekt. Om du inte gor detta s& kommer Eclipse att ge felmeddelanden da du férsoker
anvédnda dessa (t. ex. i import-satser).

o Hogerklicka pd ditt nya projekt i vansterspalten i Eclipse.
e En lang meny dyker upp, dér du véljer Build Path > Configure Build Path... .

e I rutan som dyker upp viljer du fliken Libraries.

Klicka pa Add JARs...

o I listan over projekt Oppnar du cs_pt och viljer filen cs_pt.jar. Klicka OK for att limna
projektlistan, darefter OK for att lamna Build Path-installningarna.

Nu ska ditt nya projekt kunna utnyttja kursens klasser, precis som laborationerna.



